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DNRGPS is an Open Source update to the popular DNRGarmin application. It provides users the ability to transfer
data between handheld GPS receivers and GIS software. Users will be familiar with most of the functions in DNRGPS
because they were also found in DNRGarmin.

DNRGPS:

• accomodates newer GPS models

• works with ArcGIS 10, and

• is available for the Open Source community to modify and share

Download DNRGPS

Functionality Detail
Upload/Download waypoints,tracks,routes supported FILE TYPES
Convert between points, lines and areas
Calculate Circular Error Probability
Image hotlinking
Real-time tracking
Set projections
USB connectivity

This program integrates GIS Software (ESRI’s ArcMap, Google Earth) with GPS units. It uses a C# program that
interacts with the GPS via a serial/USB port allowing GIS users to transfer Waypoints, Tracks, and Routes from a
GPS to ArcMap or Google Earth and store them as points, lines or polygons. Information can also be uploaded from
various FILE TYPES to the GPS and used as waypoints, tracks, or routes.

DNR GPS can also be used to perform real-time tracking with your GPS and GIS. Connected to a laptop computer
with ArcMap, a Garmin GPS can be a valuable tool for locating oneself and for interactive data collection.

CONTENTS 1
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CHAPTER

ONE

INSTALLATION

DNRGPS is a self-contained program which means it can be run from anywhere – your hard drive, a thumb drive, a
network location. Simply unzip the DNRGPS folder and place in the location of your choice.

Users:

• ArcGIS

– Compatible with versions 10.0 and above.

– There is no longer a Toolbar within ArcMap. All communication is instigated from DNRGPS

• Google Earth

– Best with version 3.0.0762 and above

Support discontinued for:

• Arcview 3.x

• ArcGIS 9.x

• ArcExplorer

Installation issues: None reported (Report an issue)

Note: You do NOT need to uninstall the previous version of DNRGarmin to run DNRGPS. If you do have
DNRGarmin installed, the first time you open DNRGPS, it will ask if you want to import properties from the previous
version (DNRGarmin).

Administrators: Check out the SYSTEM ADMINISTRATOR GUIDE for more details on customizing the application
for your users.

3

http://www.assembla.com/spaces/dnrgps/support/tickets/new


DNRGPS Documentation, Release 6.0.0.8

4 Chapter 1. INSTALLATION



CHAPTER

TWO

MENU OPTIONS

Most of the functionality contained within the DNRGPS program can be found within the menus.

2.1 FILE MENU

2.1.1 LOAD FROM

Used to load data from a file, database, or GIS (ArcMap, Google Maps) into the Data Table.

When loading data, DNRGPS looks for information vital to loading into the GPS. Information such as Lat, Long,
Ident, and Comment.

The default projection in DNRGPS will automatically be changed to match the projection of the loaded data:

Note: You may see this message even if you have the proper projection already set. See TROUBLESHOOT for more
details.

File

Identify the file type to load (supported FILE TYPES) and navigate to a location.

5
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Database

Load from an existing database connection by selecting a database under Database Name, and all the available layers
appear in the Layers list box.
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Edit or delete an existing connection, or add a new connection using the buttons below the Database Names.

PostgreSQL for PostGIS - Set up a connection to a PostgreSQL database and select layers to load.
Connection name is the name that displays in the list of available databases.

Note: There are 2 types of shapes that can be saved in a Postgres Database: Esri and Open Source.
DNRGPS saves and reads the open source shapes.

2.1. FILE MENU 7
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ESRI File Geodatabase (v10.x) - Navigate to an ESRI File Geodatabase and select feature classes to
load. Note: The open source File Geodatabase reader/writer that DNRGPS uses does not work with
feature datasets.

Google Keyhole Markup Language - For a KML file with more than one layer, navigate to it and select
which layers you want to load. A layer is reflected as a folder in Google Earth.

ArcMap

Only works if ArcMap is open.

Layer - Load data from a layer in the active data frame. If a layer is selected it will load from it, otherwise
you’ll be prompted to select the proper layer. Will grab the selection set or all if no records selected.

Selected Graphics - Load data from ArcMap Graphics in the active data frame. Selected graphics do not
all need to be of the same shape type. Points will be loaded as waypoints; lines and polygons are loaded
as tracks.

Google Earth

Only works if Google Earth is installed (doesn’t need to be open).

8 Chapter 2. MENU OPTIONS
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My Places - Loads data from Google Earth’s “My Places”. User is prompted to identify the layers to load
from my places. Layere are represented as folders in Google Earth.

See Also

• DOWNLOADING DATA

• SAVE TO

2.1.2 SAVE TO

Save data to a file, database, or GIS graphic after downloading from the GPS. Except for GPX or KML files, saves
data only from the active tab (waypoints, tracks, or routes) in the data table. For tracks or routes, will prompt for the
shape type (point, line, or polygon).

Note: Multi-shape options retain the shape characteristics of tracks.

File

Identify the file type to save to (supported FILE TYPES) and navigate to a location.

2.1. FILE MENU 9
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For file types that support multiple GPS data types being stored together, you will see the following prompt:

For file types that do not support multiple data types, it will save data from the active table.

10 Chapter 2. MENU OPTIONS
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Database

Save to an existing database connection by selecting a database under Database Name, and all the existing layers
appear in Layers.

Edit or delete an existing connection, or add a new connection using the buttons below the Database Names.

PostgreSQL for PostGIS - Set up a connection to a PostgreSQL database and select/specify target layer.

2.1. FILE MENU 11
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Note: There are 2 types of shapes that can be saved in a Postgres Database: Esri and Open Source.
DNRGPS saves and reads the open source shapes.

ESRI File Geodatabase (v10.x) - Navigate to an ESRI File Geodatabase and select/specify target feature
class.

Google Keyhole Markup Language - To add to an existing KML file, navigate to it and select/specify
target layer.

Web Service

Not yet implemented

ArcMap

Only works if ArcMap 10.x is open.

File - Saves data as a file and adds as a layer to the active data frame

Database - Saves data to an EXISTING database.

Graphics - Saves data as projected graphics. Requires that a projection be set on the dataframe.

12 Chapter 2. MENU OPTIONS
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Google Earth

Not yet implemented!

Only works if Google Earth is installed (doesn’t need to be open).

My Places - Saves to Google Earth’s My Places folder. If saving tracks or routes you are prompted to
identify the type of data to save (Point, Line, Polygon).

See Also

• UPLOADING DATA

• LOAD FROM

2.1.3 FILE PROPERTIES

Data Types

Select which file types will show up in the dropdown menus in the save/load dialogs.

See Also

• LOAD FROM

• SAVE TO

Projection

See SET PROJECTION

2.1. FILE MENU 13
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Waypoint

See WAYPOINT PROPERTIES

Track

See TRACK PROPERTIES

Route

See ROUTE PROPERTIES

Real Time

See REAL TIME PROPERTIES

2.1.4 SET PROJECTION

The DNRGPS program has an integrated projection utility that allows users to save and load projected data without
the need for external GIS programs such as ArcMap. The projection utility used is called Proj.4. Proj.4 was originally
written by Gerald Evenden of the USGS and has since been managed by Frank Warmerdam as open source code at
http://www.remotesensing.org/proj/. PROJ.4 is in active use by GRASS, MapServer, PostGIS, Thuban, OGDI and
OGRCoordinateTransformation as well as various other projects.

14 Chapter 2. MENU OPTIONS
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Interface:

• POSC (Petrotechnical Open Standards Consortium) Codes are unique codes assigned to specific projections.
These codes are a standard that most projection engines (including ESRI’s) can use. If you know the POSC
code of your projection you can simply select it from this list of codes.

• Datums - A list of Datums that are available. When you select a Datum a number of Projections will appear in
the Projections listbox associated with your selection.

• View Only Favorites - This checkbox filters the lengthy list of projections into just a list of the projections you
actually use. To view all projections, uncheck this option. Selecting a new projection automatically adds that
projection to your favorites. Alternatively, to add or remove a projection from your list of favorites, right click
on that projection in the Projections list and select Add To Favorites.

• Projections - List of projections that exist for the selected datum.

• Projection Description - This box contains parameters for the selected projection that will be used in the
projection process.

• - This will select the “No Projection” option which is: POSC Code: 4326, Datum: WGS 84, Projection:
No Projection (Lat/Long)

2.1. FILE MENU 15
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• - This will select the Minnesota DNR default projection which is: POSC Code: 26915, Datum: NAD83,
Projection: UTM Zone 15N

• - Can’t find the projection you’re looking for? This will import an existing projection from an Esri PRJ file
or a Well Known Text (wkt) file for a specific projection. This projection will be saved in your list of favorite
projections.

Note: Each time you set a projection, that projection is added to your favorites if it wasn’t already in them. You can
still remove that projection from your favorites by right-clicking.

2.1.5 LAUNCH GPS BABEL

GPS Babel is the open source software that DNRGPS uses to communicate with GPS units. It also has its own user
interface. For more information, go to http://www.gpsbabel.org/

2.2 EDIT MENU

Used to manage the information within the GPS data table. For more info on editing the table go to Data Table.

2.2.1 COPY

(Ctrl+C)

Copy the selected cells to the clipboard. You can copy and paste to and from MS Excel or from other cells in DNRGPS.

See Also: PASTE

2.2.2 PASTE

(Ctrl+V)

Paste information from clipboard into cells. You can paste information copied from MS Excel or from other cells in
DNRGPS.

See Also: COPY

2.2.3 DELETE SELECTION

Delete selected cells. If a whole record is selected then deletes the record.

2.2.4 EMPTY TABLE

Removes all the contents of the Data Table.

16 Chapter 2. MENU OPTIONS
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2.2.5 CONVERT TABLE TO

Convert Table To =>

• Waypoints

• Tracks

• Routes

• Realtime

Converts data from the active table to another GPS data type.

2.2.6 PROJECT COORDINATES

Takes values from Lat/Long fields and projects to the user-specified projection. Places the projected coordinates in
x_proj and y_proj.

See Also

• UNPROJECT COORDINATES

• SET PROJECTION

2.2.7 UNPROJECT COORDINATES

Takes values from Y_proj and X_proj fields and unprojects from the user-specified projection. Places the unprojected
coordinates in the lat and long fields.

See Also

• PROJECT COORDINATES

• SET PROJECTION

2.2.8 CALCULATE LOCAL TIME

Looks in COMMENT, TIME, and DATE fields for valid UTC date information, converts it to the computer’s local
time, and stores it in the LTIME field.

See Also: CALCULATE UTC TIME

2.2.9 CALCULATE UTC TIME

Looks in the LTIME field for valid local times, converts them to UTC time, and stores them in the TIME field.

See Also: CALCULATE LOCAL TIME

2.2.10 CALCULATE CEP

Allows user to calculate the Circular Error of Probability for the current records in the Data Table. This functionality
can help determine the accuracy of your GPS Unit at a given location and a given time. Because of a variety of factors
(multi-path, satellite configuration changes, atmospheric conditions, etc.), points collected in the same location will
not be recorded at the exact same coordinates, they will wander a bit. The CEP option uses a reference point, either

2.2. EDIT MENU 17
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supplied by the user or by calculating the average of all the points, to generate a series of circles that represent the
50%, 90%, 95% and 98% circular error of probability.

1. Load the points into the data table. All points in the table should reference the same location. (To create these
points, collect track points every 5 seconds for 30 minutes with your GPS sitting in one location. Then download
the track file to DNRGPS.)

2. Go to Edit => Calculate CEP. A Calculate CEP window will appear.

If you know the exact coordinates of the location where the data was collected, select the “Known Coordinate”
option and enter in the coordinates. If these coordinates are not known, select the “Average XY” option. The
average point location will be used in lieu of a known point.

3. Click on the “Calculate” button. A report is generated that gives various statistics of the scattered points,
including the Circular Error Probability measurements.

18 Chapter 2. MENU OPTIONS
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The example above states that 50% of the track points are located within 113.51 meters of the actual location
(would calculate from average location if that was entered in step 2). 95% of the points are within 570.60 meters
of the known location and 98% are within 945.93 meters. Note that this example was derived from a small
number of points, so your ranges are likely to be far smaller.

4. (Not yet functioning) If ArcMap is open you can click on the “Plot” button to plot out the results on a map to
give a visual explanation of the report. Save your track points to a point file and view them too.

Note: The Data Frame must be projected in order to plot to the map. The Data Frame’s projection will be used to
place the graphics on the screen.

2.2.11 ADD HOTLINK IMAGES

Many people use their GPS in conjunction with a digital camera. A conservation officer may mark a waypoint where
an environmental offense occurred and also take a picture of it. A parks worker may have a waypoint for each campsite
in a state park as well as a photo of each campsite. The DNR GPS program allows you to match up the GPS data with
digital images so that the Hotlinking capabilities of ArcMap may be used.

Match Images to GPS Data Directions:

1. Download Waypoints or Tracks from the GPS or load a waypoint/track file.

Note: If the original image date and time is not recorded you will not be able to create the hotlinks based on a
date/time match.

2. Go to Edit => Add Image Hotlinks. In the Image Linking form that opens, for the Images Location, navigate
to the folder where the images are stored.

2.2. EDIT MENU 19
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3. Specify a Time Calibration (Optional). If you know the clock time difference between the GPS and Camera
you may enter that into the Calibration section. Alternatively, if for one of the images, you know which waypoint
it matches, click the Set button to open up the GPS/Image Time Calibration dialog box. Click on the image in
the Image Linking dialog box and the corresponding waypoint in the data table to compare the timestamps of
the image and point. The Calibration value will automatically populate; then click OK. Most of the time, your
GPS clock and your Digital Camera clock will not match exactly. By setting a calibration value you identify the
time offset between the two.

4. Specify a Time-Match Threshold in hh:mm:ss. This threshold identifies the maximum time differential that
may exist between a waypoint and a matching image. For example, if the threshold is set to 5 minutes, a
waypoint will not match to any image that has a date/time greater than 5 minutes from its own date/time.

5. Click Match Image to GPS Data. Each waypoint date will be compared to each image date and the image with
the best match will be added to the FILENAME field in the waypoint table.

20 Chapter 2. MENU OPTIONS
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6. Save the Waypoint table to a shapefile in ArcMap. Make the new layer active and use the hotlink tool to analyze
the results. Note: You may save as a shapefile outside of ArcMap as well and then later open it in ArcMap to
use its hotlinking capabilities.

Convert Images to Waypoints Directions:

If your photos already have spatial information tagged, you can use this option to create waypoints that can link to
these photos in ArcMap.

1. Go to Edit => Add Image Hotlinks. In the new Image Linking form that opens, for the Images Location,
navigate to the folder where the images are stored.

2. Click Convert Images to Waypoints. For each georeferenced image in the specified folder, a new waypoint
will be created. All fields available in the tags of the jpg file will be populated for the waypoints, including
Lat/Long, y_proj/x_proj, filename, time, ltime, altitude, etc.

2.3 GPS MENU

2.3.1 CONNECT TO DEFAULT GPS PORT

When DNRGPS is first opened, it will automatically search the default port for a GPS unit. If it finds one, it will
attempt to connect to it.

Connect to Default GPS will retry connecting to the default port. If this doesn’t work, use Find GPS to search all ports.

2.3. GPS MENU 21
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2.3.2 FIND GPS

The Find GPS menu option searches all COM ports, USB ports, and Windows drives for valid GPSs. If it finds more
than one it’ll prompt you to select the proper unit. If you plug in a GPS unit into the default port after opening DNR
GPS, or want to switch units using the default port, use GPS => Connect to Default GPS Port to connect. If Connect
to Default GPS Port does not work, try Find GPS to retrigger the automatic search for GPS units.

2.3.3 DOWNLOAD ALL

Downloads all content (waypoints, tracks, and routes) from the connected GPS to the Data Table. Newer GPS models
will prompt you with a popup window with a list of all of the GPX files on the connected GPS device. Select which
content you want to download, or choose select all.

Each GPX file can contain one or many waypoints, tracks, and / or routes. DNRGPS cannot determine which of these
each GPX file contains without loading it. Many of these have Date/Time stamps for names. They identify the date
that information was collected. If you’re not sure which file stores the data you need you can choose the select all
button and download everything.

If you have a lot of content this can take a while. When the download is completed, the tables will be populated, and
you will get a popup that says Download Complete.

Note: The Download All option clears the data table prior to download, so any content in the data table will be
cleared whenever you run this tool. To avoid clearing all tables when downloading from a GPS, select Download from
the Waypoint, Track, or Route menu.

22 Chapter 2. MENU OPTIONS
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See Also:

• CONNECT TO DEFAULT GPS PORT

• UPLOAD ALL

2.3.4 UPLOAD ALL

Uploads all GPS data (waypoints, tracks, and routes) from the Data Tables to the connected GPS device. Newer GPS
models prompt the user for a name for the new gpx file to be created (a timestamp is automatically appended).

To only upload waypoints, tracks, or routes instead of all three, select Upload from the Waypoint, Track, or Route
menu.

Depending on your GPS Model the IDENT field may contain anywhere from 6-many characters. Waypoints uploaded
with IDENT values longer than the model allows will have the IDs automatically concatenated. If two waypoints have
the same concatenated ID they will overwrite each other.

One of the things that you have to watch out for is the overwriting of waypoints in the GPS. Each waypoint in the GPS
has an ID. When you upload waypoints, any waypoint in the gps that has the same ID as an uploading waypoint
will be overwritten. This is especially dangerous when you upload graphics as waypoints. Because graphics don’t
have any attributes the extension gives each waypoint a sequential ID 1 - n number of graphic points. It is really easy
to overwrite waypoints this way so make sure you have planned accordingly.

See Also:

• CONNECT TO DEFAULT GPS PORT

• DOWNLOAD ALL

2.4 WAYPOINT MENU

Used to pass Waypoints between the GPS and the DNRGPS data table.

2.4.1 DOWNLOAD

Downloads all waypoints from the GPS to the Data Table.

Newer GPS models pull up a popup window with a list of all of the gpx files on the connected GPS device. Select
which content you want to download, or choose select all.

See Also:

• CONNECT TO DEFAULT GPS PORT

• DOWNLOAD ALL

• UPLOAD

• WAYPOINT PROPERTIES

2.4.2 UPLOAD

Uploads all waypoints from the Data Table to the connected GPS device. Newer GPS models prompt the user for a
name for the new gpx file to be created.

2.4. WAYPOINT MENU 23
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Depending on your GPS Model the IDENT field may contain anywhere from 6-many characters. Waypoints uploaded
with IDENT values longer than the model allows will have the IDs automatically concatenated. If two waypoints have
the same concatenated ID they will overwrite each other.

One of the things that you have to watch out for is the overwriting of waypoints in the GPS. Each waypoint in the
GPS has an ID. WHEN YOU UPLOAD WAYPOINTS - ANY WAYPOINT IN THE GPS THAT HAS THE SAME
ID AS AN UPLOADING WAYPOINT, WILL BE OVERWRITTEN. This is especially dangerous when you upload
graphics as waypoints. Because graphics don’t have any attributes the extension gives each waypoint a sequential
ID 1 - n number of graphic points. It is really easy to overwrite waypoints this way so make sure you have planned
accordingly.

See Also:

• CONNECT TO DEFAULT GPS PORT

• UPLOAD ALL

• DOWNLOAD

• WAYPOINT PROPERTIES

2.4.3 WAYPOINT PROPERTIES

24 Chapter 2. MENU OPTIONS
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When downloading data from the GPS, you may have noticed that many fields with no value get created for each
record. You have the ability to customize the visible fields by going to the Properties menu item under each of the
following menus: Waypoint, Track, Route, or Real-Time.

Uncheck the fields you do not want to see and click ‘OK’. Next time you download data, only the fields that are
checked will be visible. Note: There are some required fields that will not allow you to uncheck them.

You also have the ability to customize field names by setting field aliases. The alias is what will show up in the data
table as well as what will appear in the saved file.

Note: You can now also modify the field Type, Length, and Precision.

See Also:

• UPLOAD

• DOWNLOAD

2.5 TRACK MENU

Used to pass Tracks between the GPS and the DNRGPS data table.

2.5.1 DOWNLOAD

Downloads all tracks from the GPS to the Data Table.

Newer GPS models pull up a popup window with a list of all of the gpx files on the connected GPS device. Select
which content you want to download, or choose select all.

Notes:

• The IDENT field displays the saved track name. If it is in the active log it may say ACTIVE LOG (depending
on your GPS Model).

• Saved tracks (on the GPS) may not retain all information for each point. To retain the maximum of information
possible, leave tracks in the Active Log.

• After downloading, save to a point shapefile to retain attributes for each individual point (timestamp, depth, etc).

• If saving to a line, a track line (from gray record to gray record) must contain at least 2 valid points. If not, that
record will be discarded.

• If saving to a polygon, a track line (from gray record to gray record) must contain at least 3 valid points. If not,
that record will be discarded.

See Also:

• CONNECT TO DEFAULT GPS PORT

• DOWNLOAD ALL

• UPLOAD

• TRACK PROPERTIES

2.5.2 UPLOAD

Uploads all tracks from the Data Table to the connected GPS device. Newer GPS models prompts the user for a name
for the new gpx file to be created.

2.5. TRACK MENU 25
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Saves to named tracks.

Note: If saving to an old GPS model, you will be prompted to save to the active log.

See Also:

• CONNECT TO DEFAULT GPS PORT

• UPLOAD ALL

• DOWNLOAD

• WAYPOINT PROPERTIES

2.5.3 TRACK PROPERTIES

When downloading data from the GPS, you may have noticed that many fields with no value get created for each
record. You have the ability to customize the visible fields by going to the Properties menu item under each of the
following menus: Waypoint, Track, Route, or Real-Time.

Uncheck the fields you do not want to see and click ‘OK’. Next time you download data, only the fields that are
checked will be visible. Note: There are some required fields that will not allow you to uncheck them.

You also have the ability to customize field names by setting field aliases. The alias is what will show up in the data
table as well as what will appear in the saved file.
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Note: You can now also modify the field Type, Length, and Precision.

See Also:

• UPLOAD

• DOWNLOAD

2.6 ROUTE MENU

Used to pass Routes between the GPS and the DNRGPS data table

2.6.1 DOWNLOAD

Downloads all routes from the GPS to the Data Table.

Newer models pull up a popup window with a list of all of the gpx files on the connected GPS device. Select which
content you want to download, or choose select all.

A route is a collection of waypoints.

Note: The IDENT field contains the Waypoint ID. The RIDENT field contains the Route Name.

See Also:

• CONNECT TO DEFAULT GPS PORT

• DOWNLOAD ALL

• UPLOAD

• TRACK PROPERTIES

2.6.2 UPLOAD

Uploads all tracks from the Data Table to the connected GPS device. Newer GPS models prompt the user for a name
for the new gpx file to be created.

Note: Routes appear in the Route List on the GPS. Individual points are stored in the Waypoint list.

See Also:

• CONNECT TO DEFAULT GPS PORT

• UPLOAD ALL

• DOWNLOAD

• WAYPOINT PROPERTIES
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2.6.3 ROUTE PROPERTIES

When downloading data from the GPS, you may have noticed that many fields with no value get created for each
record. You have the ability to customize the visible fields by going to the Properties menu item under each of the
following menus: Waypoint, Track, Route, or Real-Time.

Uncheck the fields you do not want to see and click ‘OK’. Next time you download data, only the fields that are
checked will be visible. Note: There are some required fields that will not allow you to uncheck them.

You also have the ability to customize field names by setting field aliases. The alias is what will show up in the data
table as well as what will appear in the saved file.

Note: You can now also modify the field Type, Length, and Precision.

See Also:

• UPLOAD

• DOWNLOAD
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2.7 REAL TIME MENU

Used to interact with ArcMap in Real-Time mode. Coordinates are sent directly from the GPS to ArcMap (if ArcMap
10.x is open) and can be recorded to a file. Data is also recorded in the Data Table.

Colorado, NUVI, Oregon, and other models with a mass storage mode - These units have a different
communication protocol with the computer and, therefore, have a bit different technique for using Real-Time.
To connect to the GPS to do real-time tracking you’ll need to install the Garmin Spanner software found at
http://www8.garmin.com/support/download_details.jsp?id=1627

2.7.1 START REAL TIME TRACKING

Turns on the Real-Time tracking mode of the application. A Real-Time form (shown below) will open with various
options for real-time data collection. This form has the following options:

A: Select Output Data Types - You can choose to collect data directly into a Point, Line, or Polygon file. These radio
dials toggle between the different shape types.

B: Load Layer - Load a new or existing layer to be used for real-time data collection

C: Time Tolerance - Minimum time between collected points (in seconds)

D: Distance Tolerance - Minimum distance between collected points (in meters)

E: Record Buttons - Used to control data collection in the active layer (A). There are 4 buttons available. They are:

Mark Point - Add most current location to a point layer.

Start Recording - This starts the collection of GPS data for the active layer. If you are recording to a
point layer you’ll notice that the Count (F) will begin incrementing for each point recorded. Each point is
saved to the layer when it is created. If you are recording to a line or polygon the count will not increment
(and will not be saved to the layer) until you stop recording.

Stop Recording - Stops recording and closes the current shape (line or polygon)
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Pause Recording - Stops recording of GPS points but does not close the current shape being recorded
(line or polygon).

F: Count - Keeps a tally of the number of shapes collected per layer.

G: Show Graphics - If ArcMap is open this option determines whether a “bread crumb trail” will appear in the active
mapping window.

H: Pan Window % - Automatically pans if your current location gets too close to the edge of the screen. The Pan
Zone % allows you to define how close to the edge of the screen you can get before re-centering the map display. This
percentage defines a box as a percentage of the map window for which, if you move outside of it, the map display
automatically recenters.

I: Track Up - In ArcMap the Data Frame will display with the track direction up rather than north up.

Default Fields: Click here to get a list of all the information that may be collected in real-time mode and a list of the
fields that will be added to your attribute table if they don’t already exist.

Note: All Real-Time points will automatically be added to the GPS data table (one per second) unless a Distance
and/or Time tolerance are set. To record directly into a layer you’ll need to follow steps B-E above.

2.7.2 STOP REAL TIME TRACKING

Stops Real Time Tracking
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2.7.3 REAL TIME PROPERTIES

When downloading data from the GPS, you may have noticed that many fields with no value get created for each
record. You have the ability to customize the visible fields by going to the Properties menu item under each of the
following menus: Waypoint, Track, Route, or Real-Time.

Uncheck the fields you do not want to see and click ‘OK’. Next time you download data, only the fields that are
checked will be visible. Note: There are some required fields that will not allow you to uncheck them.

You also have the ability to customize field names by setting field aliases. The alias is what will show up in the data
table as well as what will appear in the saved file.

Note: You can now also modify the field Type, Length, and Precision.

Collect NMEA Strings - If checked when in real time mode, every NMEA string of the selected types is written out
to a file

• Path - Location of the file to populate

• $GPGGA, $GPGLL, etc. - List of NMEA strings. If checked, it will be recorded. If not, it will be ignored.

See Also: START REAL TIME TRACKING
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2.8 HELP MENU

2.8.1 Report a Bug

Pulls up a form to report software bugs or suggest enhancements for DNRGPS.

2.8.2 About

Displays the about box which contains information on the software version as well as the installation path (?).

2.8.3 Local Help File

Opens help file PDF.

2.8.4 Online Help

Opens online version of the documentation. This is the most up-to-date.
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CHAPTER

THREE

TROUBLESHOOT

• My data is not projecting correctly: Try using File -> Set Projection to correct the x_proj and y_proj values.

• I already have the correct projection set, and yet DNRGPS adds a duplicate projection definition when I load a
shapefile: There are many ways to specify the exact same projection and sometimes it is hard to tell that two
different descriptions in fact refer to the same projection. This will only happen at most once for each unique
new projection definition.
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CHAPTER

FOUR

TRANSITION FROM DNR GARMIN TO
DNR GPS

• DATA TABLE changes

– Easier field editing

– Greater user control over data

– Ability to modify more field properties (Type, Length, and Precision)

• LOAD FROM / SAVE TO: PostgreSQL databases, ESRI v10 File Geodatabases

• : DATA TABLE
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CHAPTER

FIVE

APPENDIX 1 - DATA MANIPULATION

5.1 UPLOADING DATA

There are basically 2 steps to uploading data from your PC into the GPS:

1. Load data from a file or GIS graphic into the DNRGPS Data Table

• Go to File => Load From and choose a source (File, Database, Arcmap, Google Earth). Note: To load
from Arcmap it must be running.

– NOTE: For track logs, each GPS Unit has a different amount of memory to store coordinates. If your
upload is too large you may get an error: *TBD*

• Once the data is loaded to the data tables, you may edit it prior to upload. Edits include modifying cell
values or converting between waypoints/tracks/routes. To see more options for data manipulation see the
data table page.

2. Upload data to the GPS

• To upload your entire Data Table (waypoints/tracks/routes), go to GPS => Upload All.

• To upload only waypoints, tracks, or routes, go to that GPS data type’s menu and select Upload (Waypoint
=> Upload, Track => Upload, or Route => Upload).

• Note: Uploading into the newer GPS devices, you will be prompted to specify a the name of the GPX file
that gets created.

– To change the name of an individual track you would change the IDENT value for the track header
(the dark gray record).

– To combine two tracks into a single saved track you would need to make the second track be a subset
of the first. To do this, find the first row of the second track (dark gray) and change the NEW_TRK
value to False.

– To change the name of a route you would change the rident value for the route header.

Garmin Colorado, NUVI, Oregon models - These units have a different communication protocol with the computer
and, therefore, have a bit different technique for Uploading/Downloading data. When the GPS is connected to the
computer it shows up as a mass storage device (a Drive in Windows Explorer). When you Upload data in DNRGPS
a GPX file with a timestamp for a name gets placed on the Mass Storage Device into the upload folder (usually
GARMIN/GPX). The next time the GPS is turned on this data will be incorporated into the main memory of the GPS.

See Also: DOWNLOADING DATA

37



DNRGPS Documentation, Release 6.0.0.8

5.2 DOWNLOADING DATA

There are basically 2 steps to downloading data from your PC into the GPS:

1. Download data from the GPS

• To download all GPS data types (waypoints/tracks/routes), go to GPS => Download All and select what
you want to download.

• To download only waypoints, tracks, or routes, go to that GPD data type’s menu and select Download
(Waypoint => Download, Track => Download, or Route => Download).

• Once the data is downloaded you may edit it prior to saving. Edits include modifying cell values or field
properties or converting between waypoints/tracks/routes. To see more options for data manipulation see
the data table page.

2. Save data to a file, database, or GIS graphic from the DNRGPS Data Table

• Go to File => Save To and choose a destination (File, Database, Web Service, Arcmap, Google Earth).
Note: To load from Arcmap it must be running.

• For more on saving data see Saving Data

General Information

Each waypoint, track point, and route point has one or more attributes associated with it depending on the
type of GPS receiver you have. You can choose to turn off extra columns if you don’t need them. You can
even delete individual records if you want. For more on editing the table, go to Data Table.

Data is downloaded in Lat/Long WGS84 coordinates. When the download is complete this spatial infor-
mation is projected to the user specified projection. The projected Y and X coordinates are stored in the
Y_Proj and X_Proj fields. For more on projections go to the Projection Utility.

Once you have the GPS information in the Data Table you can save it as a Text file, Shapefile, GPX file,
KML file, Mapinfo file, Arcmap Graphic, ArcMap Geodatabase Feature Class, a PostgreSQL database
feature class, or a Web Service. For more on this go to the SAVE TO page.

Garmin Colorado, NUVI, Oregon models - These units have a different communication protocol with the computer
and, therefore, have a bit different technique for Uploading/Downloading data. When the GPS is connected to the com-
puter it shows up as a mass storage device (a Drive in Windows Explorer). When you Download data using DNRGPS
it is pulling data from a GPX file on the storage device called CURRENT.GPX (possibly located at GARMIN/GPX or
GARMIN/GPX/CURRENT).

See Also: UPLOADING DATA

5.3 GPS FILE STRUCTURES AND REQUIREMENTS

The DNR GPS program looks for specific fields when loading GPS data from a file. Below are lists of fields associated
with each GPS data type. The required fields are in bold. If these fields are not found, you may be prompted to supply
the proper field for these values.

5.3.1 Waypoints

Name Description Type Length Precision
type WAYPOINT string 10 0

Continued on next page
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Table 5.1 – continued from previous page
Name Description Type Length Precision
ident Identifier string 24 0
lat Latitude number 18 8
long Longitude number 18 8
y_proj Projected Y Coordinate number 18 8
x_proj Projected X Coordinate number 18 8
comment User Comment string 254 0
display Display Options string 10 0
symbol Waypoint Symbol string 10 0
dist Proximity Distance number 12 2
proximity Proximity Index string 10 0
color Color string 10 0
altitude Altitude number 12 2
depth Depth number 12 2
temp Temperature number 12 2
time Time/Date string 20 0
wpt_class Waypoint Class string 10 0
sub_class Subclass string 10 0
attrib Attributes string 10 0
link Link to Additional Info string 254 0
state State string 15 0
country Country Code string 15 0
city City Name string 15 0
address Address Number string 15 0
zip Zip Code string 15 0
facility Facility Code string 15 0
crossroad Intersecting Road Label string 15 0
ete Estimate Time Enroute string 10 0
dtype string 10 0
model GPS Model string 20 0
filename Hotlink Filename string 254 0
ltime Local Time string 20 0
magvar Magnetic Variation number 10 2
geoidheight Height Above WGS84 number 10 2
desc Text Description string 254 0
fix Type of GPX Fix string 5 0
sat Number of Satellites number 5 0
hdop Horizontal DOP number 5 2
vdop Vertical DOP number 5 2
pdop Dilution of Precision number 5 2
ageofdgpsdata Age (in seconds) number 10 0
dgpsid ID of DGPS Station number 4 0
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5.3.2 Tracks

Name Description Type Length Precision
type TRACK string 10 0
ident Identifier string 24 0
lat Latitude number 18 8
long Longitude number 18 8
y_proj Projected Y Coordinate number 18 8
x_proj Projected X Coordinate number 18 8
comment User Comment string 254 0
new_trk New Track string 10 0
new_seg New Track Segment string 10 0
display Display on Map? string 10 0
color Color string 10 0
altitude Altitude number 12 2
depth Depth number 12 2
temp Temperature number 12 2
time UTC Date-Time string 20 0
model GPS Model string 20 0
filename Hotlink Filename string 254 0
ltime Local Time string 20 0
desc Text Description string 254 0
link Link to Additional Info string 254 0

5.3.3 Routes

Name Description Type Length Precision
type ROUTE string 10 0
ident Identifier string 24 0
lat Latitude number 18 8
long Longitude number 18 8
y_proj Projected Y Coordinate number 18 8
x_proj Projected X Coordinate number 18 8
new_seg New Route Segment string 10 0
rnumber Route Number string 12 0
rident Route Identifier string 10 0
rcmnt Route Comment string 10 0
rdesc Route Descrtipion string 10 0
rlink Route Link string 10 0
rtype string 12 0
comment User Comment string 254 0
display Display Options string 10 0
symbol Waypoint Symbol string 10 0
dist Proximity Distance number 12 2
proximity Proximity Index string 10 0
color Color string 10 0
altitude Altitude number 12 2
depth Depth number 12 2
temp Temperature number 12 2
time Time/Date string 20 0

Continued on next page
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Table 5.2 – continued from previous page
Name Description Type Length Precision
wpt_class Waypoint Class string 10 0
sub_class Subclass string 10 0
attrib Attributes string 10 0
state State string 15 0
country Country Code string 15 0
city City Name string 15 0
address Address Number string 15 0
zip Zip Code string 15 0
facility Facility Code string 15 0
crossroad Intersecting Road Label string 15 0
ete Estimate Time Enroute string 10 0
dtype string 10 0
filename Hotlink Filename string 254 0
ltime Local Time string 20 0
magvar Magnetic Variation number 10 2
geoidheight Height Above WGS84 number 10 2
desc Text Description string 254 0
model GPS Model string 20 0
fix Type of GPX Fix string 5 0
sat Number of Satellites number 5 0
hdop Horizontal DOP number 5 2
vdop Vertical DOP number 5 2
pdop Dilution of Precision number 5 2
ageofdgpsdata Age (in seconds) number 10 0
dgpsid ID of DGPS Station number 4 0
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5.3.4 Real Time

Name Description Type Length Precision
type ROUTE string 10 0
ident Identifier string 24 0
lat Latitude number 18 8
long Longitude number 18 8
y_proj Projected Y Coordi-

nate
number 18 8

x_proj Projected X Coordi-
nate

number 18 8

comment string 254 0
altitude Altitude number 12 2
epe Estimated Position Er-

ror - 2 sigma
number 10 2

eph EPE, but horizontal
only

number 10 2

epv EPE, but vertical only number 10 2
hdop Horizontal DOP number 5 2
vdop Vertical DOP number 5 2
pdop Dilution of Precision number 5 2
speed Speed Over Ground

(knots)
number 10 2

course Course Over Ground
(degrees)

number 10 2

mvar Magnetic Variation
(degrees)

number 10 2

mdir Magnetic Variation
(E/W)

number 10 2

datum Datum of coordinates string 20 0
pfix Type of position fix

• 0 = Unusable
• 1 = Invalid
• 2 = 2D
• 3 = 3D
• 4 = 2D_diff
• 5 = 3D_diff

number 10 0

east Velocity East string 10 0
north Velocity North string 10 0
up Velocity Up number 10 2
depth Depth Below Trans-

ducer
number 12 2

temp Temperature (Celcius) number 12 2
time UTC Time string 20 0
filename Hotlink filename string 255 0
ltime Local Time string 20 0
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5.4 DATA TABLE

The Data Table can be used as a tool to manage waypoints, tracks, routes, and real-time data.

5.4.1 Editing Table Information

Editing the data table in DNRGPS is much simplified and improved from DNRGarmin. Editing cells now operates
much the same as any spreadsheet program (such as Excel).

Modifying Cell Values Click on a cell once to select. Click again or press F2 to modify the cell content.

Adding Records The last row in the data table is always a new record. Start typing into one of the cells of that row
to create the new record.

Deleting Records Select an entire row by clicking the row header to the left of each record. To select multiple rows,

click and drag, ctrl-click, or shift-click. Once the desired rows are selected. Click the delete button: . To

clear the entire data table, use the (Clear Table) button.

Deleting (hiding) Columns You can toggle columns on or off through the properties menu for Way-
point/Track/Route. Uncheck the checkbox to the left of the field to turn off the column.

Saving Data When you save your data, if you have a selection of whole rows, only those records that are selected are
saved to a shapefile, graphic or text file. If you have no records selected then all records will be saved. To clear
the selection, click in any single cell in the table.

Copying and Pasting Data You can copy and paste data to and from Excel and within the data table using the

(Copy from cells) and (Paste into table) buttons. The selection for the copy can be individual cell(s) or full
row(s).
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Roll up Tracks If a track record has a “-” in the row header, it is the start of a track. You can double-click on it to
hide all records within that track.

Sorting To sort a wapoint table based on a specific field click on the field header. Note: You are unable to sort track
and route tables because they rely on a specific record order.

Note: There is no longer a limit to the number of records in the data table.

5.5 FILE TYPES

DNRGPS supports loading data from or saving data to the following file types:

ESRI Shapefile - Only contains one data type (points, lines, or polygons). If the shapefile does not have a prj file, then
it assumes data is projected in the projection specified at File => Set Projection. Loading from or saving to shapefiles
does not require ArcMap.

Google Keyhole Markup Language (KML File) - Can store waypoints, tracks, and routes together. For more
control over which layers you import, load the KML by connecting to it as a database. Also, save to a database
connection instead of a file for more control over the name of the target layer. For more on this file format go to
http://earth.google.com/kml/

GPS Exchange Format (GPX File) - Can store waypoints, tracks, and routes together. For more on this file format
go to http://www.topografix.com/gpx.asp

Text File (comma-delimited) or Text File (tab-delimited) - Can be used to load data or save out data.

Mapinfo File (.map) - This functionality does not yet work. If no projection information is associated with this file,
then it assumes data is projected in the projection specified at File => Set Projection.

Geography Markup Language (GML) - For more on this file format go to
http://www.opengeospatial.org/standards/gml

Geo JavaScript Object Notation (GeoJSON) - For more on this file format go to http://geojson.org/

See Also

• LOAD FROM

• SAVE TO
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CHAPTER

SIX

APPENDIX 2

6.1 CONTRIBUTORS

Authors – the people behind DNRGPS

Lead Programmer:

• Chris Pouliot

Code Contributors:

• Regan Sarwas

• Greg Massaro

Project Manager:

• Shelly Sentyrz

Other contributors and helpers:

• Zeb Thomas

• Mike Tronrud

• Jackie Brost

• Hundreds of alpha and beta testers

6.2 KNOWN ISSUES

DNRGPS Known Functionality Gaps and Issues

For the most current list, go to
ftp://ftp.dnr.state.mn.us/pub/gisftp/DNRGPS/DNRGPS_KNOWN_ISSUES.TXT

6.3 LICENSE

6.3.1 DNRGPS Licensing

Copyright (c) 2000-2012 Minnesota Department of Natural Resources (www.mndnr.gov)
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Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documen-
tation files (the “Software”),to deal in the Software without restriction, including without limitation the rights to use,
copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom
the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PAR-
TICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION
OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFT-
WARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

6.3.2 Component Licensing

DNRGPS contains several component packages that are provided under their own licensing terms.

GDAL – Refer to the GDAL license found at /DOCUMENTS/GDAL_LICENSE.TXT

GPSBABEL – Refer to the GPSBABEL license found at /DOCUMENTS/GPSBABEL_LICENSE.TXT

PROJ4 –Refer to the PROJ4 license found at /DOCUMENTS/PROJ4_LICENSE.TXT

ESRI FILE GDB API – Refer to the ESRI FILE GDB API license found at /DOCU-
MENTS/FILEGDBAPI_LICENSE.TXT

6.4 RELEASE LOG

Release log can be found at:
ftp://ftp.dnr.state.mn.us/pub/gisftp/DNRGPS/DNRGPS_RELEASE_LOG.TXT
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CHAPTER

SEVEN

SYSTEM ADMINISTRATOR GUIDE

System Administrators are responsible for installing and managing DNRGPS on enterprise computers.

This section is meant to give tips on smooth roll outs to many computers.

7.1 Installation

Since DNRGPS is a self-contained program, it can be deployed anywhere. At the Minnesota DNR, we have deployed
to a central server that all users can see. A shortcut to dnrgps.exe is placed on the desktop. The advantage of this is
that new versions can be integrated by simply replacing the one copy of the application on the server instead of dozens
or hundreds of individual copies on users’ PCs.

7.2 User Properties

The first time DNRGPS is run on a PC, it tries to create a DNRGRPS folder at:

• Windows XP: C:Documents and Settings<username>AppDataDNRGPS

• Windows 7: C:Users<username>AppDataRoamingDNRGPS

If users are restricted from writing to this location, then it tries writing to:

• Windows XP: C:Documents and Settings<username>My DocumentsDNRGPS

• Windows 7: C:Users<username>My DocumentsDNRGPS

The DNRGPS folder may contain these files:

• dnrgps_temp.gpx - A scratch space that DNRGPS uses for processing

• dnrgps_properties.xml - User customizations. This file is first generated from a master copy located in DNRG-
PSdocuments. For more go to the description of the dnrgps_properties.xml

• DNRGPS_log.txt - Error log file

When deploying, modify the main dnrgps_properties.xml file to include customizations of your choice such as field
aliases, visible file types, favorite projections, etc. These customizations will then be used by the end user. Note: If
the end user has previously opened DNRGPS they will already have a local copy of dnrgps_properties.xml. This file
will need to be deleted or replaced for them to see the updated customizations.
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7.3 dnrgps_properties.xml File Structure

Below is a list of the properties that can be modified within the dnrgps_properties.xml prior to deployment:

• time - Timestamp from the last time DNRGPS modified this xml file.

• checkVersion - Boolean that determines whether, each time DNRGPS opens, it checks whether there is a newer
version available for download. Set this to false to prevent your users from seeing this message for each update.

<CheckVersion>true</CheckVersion>

• GpsBabelExecutable - Path to GPD Babel application used by DNR GPS

<GpsBabelExecutable>C:\dnrgps\gpsbabel\gpsbabel.exe</GpsBabelExecutable>

• xImageExecutable - Path to xImage application used by DNR GPS

<xImageExecutable>C:\Program Files (x86)\Garmin\xImage\xImage.exe</xImageExecutable>

• GPS Model and Connections - gpsMake, gpsPort, gpsBaudRate, gpsNoAck

<!--Items below relate to GPS Model and Connections-->
<gpsMake></gpsMake>
<gpsPort></gpsPort>
<gpsBaudRate>9600</gpsBaudRate>
<gpsNoAck>True</gpsNoAck>

• Field Definitions - Field definitions for each field are similar across the different data types (waypointFields, trackFields, routeFields, realtimeFields). Possible field tags include:

– gpxtag - The tag used for a gpx file (if applicable)

– required - Whether the field is required for that data type

– visible - Whether the field defaults to being displayed for that data type

– precision - For numerical fields, the precision of the value, the 0 is ignored for other values.

– length - Field length

– type - Field data type

– name - Field name

– alias - Field alias (if applicable)

Note: If a tag is missing, it is not applicable to that field. Example field definitions (these default definitions
can be changed by the user in DNRGPS properties)

<field gpxtag="name" required="true" visible="true" precision="0" length="24" type="string" name="ident" />
<field gpxtag="lat" required="true" visible="true" precision="8" length="18" type="number" alias="Latitude" name="lat" />
<field gpxtag="DisplayMode" visible="true" precision="0" length="10" type="string" name="display" />

• Real-Time Tracking properties - Set the defaults for the Real Time Window (all of these options can still be
changed by the user in the dialog box)

– rtAutoPanEnabled - Boolean enabling / disabling pan capability

– rtAutoPanWindowPercent - Sets default percentage for how close to the edge of the screen
you can get before re-centering the map display. This percentage defines a box as a percentage
of the map window for which, if you move outside of it, the map display automatically recenters.

– rtGraphicsEnabled - Boolean enabling / disabling marking the trail in the active mapping win-
dow if ArcMap is open
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– rtToleranceDistanceEnabled - Boolean enabling / disabling the use of a tolerance distance

– rtToleranceDistanceValue - If tolerance distance is enabled, the minimum distance between
point collections (in meters)

– rtToleranceTimeEnabled - Boolean enabling / disabling the use of a tolerance time

– rtToleranceTimeValue - If tolerance time is enabled, the minimum time between point collec-
tions (in seconds)

– rtTrackUp - Boolean setting for whether ArcMap displays North as up, or the track direction
as up

– rtNMEA - Sets whether NMEA tags are collected and the default file to record them

<!--Items below relate to Real-Time Tracking properties-->
<rtAutoPanEnabled>True</rtAutoPanEnabled>
<rtAutoPanWindowPercent>75</rtAutoPanWindowPercent>
<rtGraphicsEnabled>True</rtGraphicsEnabled>
<rtToleranceDistanceEnabled>False</rtToleranceDistanceEnabled>
<rtToleranceDistanceValue>5</rtToleranceDistanceValue>
<rtToleranceTimeEnabled>True</rtToleranceTimeEnabled>
<rtToleranceTimeValue>3</rtToleranceTimeValue>
<rtTrackUp>False</rtTrackUp>
<rtNMEA enabled="False" path="" />

• Hotlinking - Set the defaults for the Image Linking window (thesee options can still be changed by the user in the dialog box)

– hotlinkCalibration - Estimated offset between picture timestamp and GPS data point timestamp

– hotlinkThreshold - Maximum offset allowed for a match

<!--Items below relate to Hotlinking-->
<hotlinkCalibration>-00:00:34</hotlinkCalibration>
<hotlinkThreshold>00:06:00</hotlinkThreshold>

• Projections - Set the defaults for the Image Linking window (thesee options can still be changed by the user in the dialog box)

– projections[viewonlyfavorites] - If set to true, only projections that have previously been used or
been set as favorites will appear in the long list of projections. If set to false, all projections will
appear by default. There is a checkbox for the user to toggle this on and off.

– projection - This is the list of projections (defined by posc, datum, projname, and projdescription)
that are currently in the user’s favorites, so prior to deployment the system administrator can set up
default projections. See SET PROJECTION for more information on the projection parameters.

<!--Items below relate to Projections-->
<projections viewonlyfavorites="true">

<projection posc="4326" datum="WGS 84" projname="No Projection" projdescription="+proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs &lt;&gt;" default="false" />
<projection posc="26915" datum="NAD83" projname="UTM zone 15N" projdescription="+proj=utm +zone=15 +ellps=GRS80 +datum=NAD83 +units=m +towgs84=-0.991,1.9072,0.5129,0.02579,0.00965,0.01166,0 +no_defs no_defs &lt;&gt;" default="false" />
<projection posc="20120112020639" datum="North_American_Datum_1983" projname="NAD_1983_UTM_Zone_15N" projdescription="+proj=utm +zone=15 +datum=NAD83 +units=m +no_defs " default="true" />

</projections>

• File Types - List of file types to diplay in Load From File and Save To File. Each fileType tag has the following parameters:

– gdaltype (all but text files) - Data type keyword used by GDAL

– delimiter (text files only) - Delimiter used in the input / output text file

– suffix - Suffix of the file type’s filename
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– description - Description used in the Load From File and Save To File file navigation dialog boxes

– visible - Boolean determining whether the checkbox in File Properties is checked (“true” = checked).
Set to “false” to hide by default the file types that your users will not be using.

– default - The default option in the Load From and Save To menus. Only one type can be set to default.

<!--Items below relate to File Types to save to.-->
<fileTypes>

<fileType gdaltype="ESRI Shapefile" suffix="shp" description="ESRI Shapefile" filter="*.shp" visible="true" default="true" />
<fileType gdaltype="KML" suffix="kml" description="Google Keyhole Markup Language" filter="*.kml" visible="true" default="false" />
<fileType gdaltype="GPX" suffix="gpx" description="GPS Exchange Format" filter="*.gpx" visible="true" default="false" />
<fileType delimiter="," suffix="txt" description="Text file (comma-delimited)" filter="*.txt" visible="true" default="false" />
<fileType delimiter="\t" suffix="txt" description="Text file (tab-delimited)" filter="*.txt" visible="true" default="false" />
<fileType gdaltype="MapInfo File" suffix="map" description="Mapinfo File" filter="*.map" visible="true" default="false" />
<fileType gdaltype="GML" suffix="gml" description="Geography Markup Language" filter="*.gml" visible="true" default="false" />
<fileType gdaltype="GeoJSON" suffix="geojson" description="Geo JavaScript Object Notation" filter="*.geojson" visible="true" default="false" />

</fileTypes>

• Database Types - Each database fileType tag has the following parameters (actual databases have more parameters than the psuedo-databases, i.e. file geodatabases and KML files):

– gdaltype - Database type keyword for GDAL

– prefix (databases only) - Connection string prefix for the given database

– dbname (databases only) - Boolean determining whether DB Name is visible in the connection dialog
box

– host (databases only) - Boolean determining whether Host is visible in the connection dialog box

– port (databases only) - Boolean determining whether Port is visible in the connection dialog box

– user (databases only) - Boolean determining whether User is visible in the connection dialog box

– password (databases only) - Boolean determining whether Password is visible in the connection
dialog box

– description - Text description to be shown in the dropdown menu for selecting the type of database
connection to be used

– visible - Boolean determining whether the desciption shows up as an option in the dropdown menu

– folderPath (Esri File Geodatabases only) - Boolean determining whether Folder Path is visible in the
connection dialog box

– filePath (KML only) - Boolean determining whether File Path is visible in the connection dialog box

<!--Items below relate to Database Types to save to.-->
<databaseTypes>

<fileType gdaltype="PostgreSQL" prefix="PG:" dbname="true" host="true" port="true" user="true" password="true" description="PostgreSQL for PostGIS" visible="true" />
<fileType gdaltype="FileGDB" folderPath="true" description="ESRI File Geodatabase (v10.x)" visible="true" />
<fileType gdaltype="KML" filePath="true" description="Google Keyhole Markup Language" visible="true" />

</databaseTypes>

• Database Connections - Stores the database connections set up by the user. The system administrator can set these up before deployment so they are available to all users. databaseConnection tags include:

– gdaltype - Database type keyword for GDAL

– connectionName - Name for the geodatabase that will show up in the list of connections

– connectionString - Connection string used to connect to the database
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– default - Boolean indicating which database is highlighted when the list of connections is opened.
Only one connection can be set as the default.

<!--Items below are saved database connections-->
<databaseConnections>

<databaseConnection gdaltype="FileGDB" connectionName="test GDB" connectionString="D:\gistemp\MyProjects\test.gdb" default="true" />
</databaseConnections>
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EIGHT

PROGRAMMER GUIDE

DNRGPS is Open Source code written in C#. Programmers are encouraged to modify DNRGPS code by checking it
out from http://www.assembla.com/spaces/DNRGPS.

Check code out and in here: http://www.assembla.com/spaces/DNRGPS
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